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Chapter 1. Before You Begin 

This User’s Guide describes the process for hybridization of samples prepared by methylated 
DNA immunoprecipitation (MeDIP) (and amplified by whole genome amplification [WGA] if 
necessary) on these NimbleGen arrays formats: 

 385K (385,000 features)  
 4x72K (4 x 72,000 features) 
 2.1M (2.1 million features) 
 3x720K (3 x 720,000 features) 

The first part of the process requires quality control of experimental (IP) and control (input) 
samples to verify quality prior to microarray hybridization. You then independently label these 
samples using a NimbleGen Dual-Color DNA Labeling Kit and co-hybridize them to a 
NimbleGen DNA Methylation array using a NimbleGen Hybridization System. Following 
hybridization, the arrays are washed, dried, and scanned using a NimbleGen MS 200 
Microarray Scanner. Array data are extracted and analyzed using our NimbleScan software and 
SignalMap software. 

 
Example procedures for dsDNA digestion, immunoprecipitation, and amplification 
(WGA) are described in the MeDIP protocol, available from Roche Microarray 
Technical Support. Refer to page 8 for contact information. 

What’s New? 

Version 7.1 of this User’s Guide includes instructions on using NimbleScan v2.6 Software for 
DNA methylation experiments. 

 
To verify you are using the most up-to-date version of this User’s Guide to process your 
arrays, go to www.nimblegen.com/lit/. 

http://www.nimblegen.com/lit/
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Step  Process Time 

Sample QC 0.5 h 

  

Sample Labeling 0.5 h 

    3 h 

Sample Cleanup & Quantitation 1 h 

  

Microarray Hybridization 0.5 h - 1 h 

        Overnight 

Microarray Washing 0.5 h 

   

Microarray Scanning 0.5 h 

   

Data Analysis 
385K & 4x72K Arrays: 2 h 

2.1M & 3x720K Arrays: 4 h 

Figure 1: Workflow for NimbleGen DNA Methylation Arrays. Steps in the process and estimated time for 
each step, based on the processing of one slide, are shown in the boxes. Incubation times are indicated beneath 
the appropriate process times. 

Components Supplied 

Component Description 

NimbleGen Arrays As ordered 

NimbleGen Mixers  One X1 mixer is ordered separately from the 385K array 

 One X4 mixer is provided per 4x72K array 

 One HX1 mixer is provided per 2.1M array 

 One HX3 mixer is provided per 3x720K array 

Mixer Port Seals or 
Mixer Multi-port Seals 

For sealing fill and vent ports of NimbleGen mixers: 

 Mixer ports seals are provided with X1, HX1, and HX3 mixers 

 Mixer multi-port seals are provided with X4 mixers 

CD/DVD This User’s Guide and NimbleGen design files are included in the Design Information 
CD/DVD. 
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Microarray Storage 

NimbleGen arrays are packaged with desiccant and can be stored at room temperature for use 
by the expiration date. Once the seal is broken, store NimbleGen arrays in a desiccator at room 
temperature until use. 

Protocol Information & Safety 

 Wear gloves and take precautions to avoid sample contamination. 

 Cy dyes are light sensitive. Be sure to minimize light exposure of the dyes during use and 
store in the dark when not in use. 

 Cy dyes are ozone sensitive. Take the necessary precautions to keep atmospheric ozone 
levels below 20 ppb (parts per billion). 

 Cy dyes are humidity sensitive. Take the necessary precautions to keep humidity levels 
below 40%. 

 Roche NimbleGen has found that using VWR water and DTT for all post-hybridization 
washes results in higher signal from Cy dyes. 

 
Reconstitute the DTT provided in the NimbleGen Wash Buffer Kit in a fume 
hood. Chapter 4. Hybridization and Washing provides details on how to 
reconstitute the DTT.  

 Roche NimbleGen recommends using a NanoDrop Spectrophotometer for quantifying 
and characterizing nucleic acid samples because this instrument requires only 1.5 μl of 
sample for analysis. 

 Perform all centrifugations at room temperature unless indicated otherwise. 

Required Equipment, Labware & Consumables 

You assume full responsibility when using the equipment, labware, and consumables described 
below. These protocols are designed for the specified equipment, labware, and consumables. 

NimbleGen Equipment 

Choose between 4- or 12-bay NimbleGen Hybridization Systems. 

Equipment Supplier Process Quantity Catalog No. 

05 223 652 001 (110V) NimbleGen Hybridization 
System 4* 

Roche NimbleGen 4 slides 

05 223 679 001 (220V) 

05 223 687 001 (110V) NimbleGen Hybridization 
System 12* 

Roche NimbleGen 12 slides 

05 223 695 001 (220V) 

05 223 636 001 (110V) NimbleGen Microarray 
Dryer 

Roche NimbleGen 24 slides 

05 223 644 001 (220V) 

NimbleGen MS 200 
Microarray Scanner 

Roche NimbleGen 48 slides 05 394 341 001 

* NimbleGen Hybridization Systems include an accessory kit that contains a Precision Mixer Alignment Tool (PMAT), 
Mixer Disassembly Tool, Mixer Brayer, System Verification Assemblies, replacement O-rings, and forceps. 
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Software 

Program Supplier Catalog No. 

05 933 315 001  
(Individual License) 

NimbleScan v2.6 Roche NimbleGen 

05 933 331 001  
(Site License) 

SignalMap v1.9 Roche NimbleGen 05 225 051 001  
(Individual License) 

Standard Laboratory Equipment 

Equipment Supplier Catalog No. 

Compressed Gas Nozzle TeqCom TA-N2-2000 

DNA Vacuum Concentrator Thermo Savant  

Desiccator Multiple Vendors  

Electrophoresis System Multiple Vendors  

Heat Block (capable of 
temperatures to 98°C) 

Multiple Vendors  

Microcentrifuge (12,000 x g 
capability) 

Multiple Vendors  

Microman M10 Pipette 
(recommended for 4x72K 
arrays) 

Gilson F148501 

Microman M100 Pipette 
(recommended for 385K, 
2.1M, and 3x720K arrays) 

Gilson F148504 

Spectrophotometer NanoDrop ND-1000 or newer 

Thermocycler Multiple Vendors  

Vortex Mixer Multiple Vendors  

Consumables & Accessories Available from Roche NimbleGen 

Component 
Package Size /  
Process Quantity 

Catalog No. 

5 mixers 05 391 717 001 NimbleGen X1 Mixer (for 
385K arrays; includes mixer 
port seals) 

10 mixers 05 223 725 001 

5 mixers 05 391 725 001 NimbleGen X4 Mixer (for 
4x72K arrays; includes 
mixer multi-port seals) 10 mixers 05 223 733 001 

5 mixers 05 391 733 001 NimbleGen HX1 Mixer (for 
2.1M arrays; includes mixer 
port seals) 

10 mixers 05 223 741 001 

5 mixers 05 391 741 001 NimbleGen HX3 Mixer (for 
3x720K arrays; includes 
mixer port seals) 

10 mixers 05 223 750 001 
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Component 
Package Size /  
Process Quantity 

Catalog No. 

NimbleGen Dual-Color 
DNA Labeling Kit 

Contents: 

 Nuclease-free Water  
(2 x vial 1) 

 Random Primer Buffer 
(vial 2) 

 Cy3-Random 
Nonamers (vial 3) 

 Cy5-Random 
Nonamers (vial 4) 

 Klenow Fragment 
(3'->5' exo-) 50 U/μl  
(vial 5) 

 10 mM dNTP Mix  
(vial 6) 

 Stop Solution (0.5 M 
EDTA) (vial 7) 

 5 M NaCl (vial 8) 

10 Cy3 labeling reactions and  
10 Cy5 labeling reactions 

05 223 547 001 

NimbleGen Hybridization Kit  

Contents: 

 2X Hybridization Buffer 
(vial 1) 

 Hybridization 
Component A  
(vial 2) 

 Alignment Oligo1  
(vial 3) 

 100 hybridizations using 385K arrays 

 160 hybridizations using 4x72K arrays 

 40 hybridizations using 2.1M arrays 

 102 hybridizations using 3x720K arrays 

05 583 683 001 

NimbleGen Hybridization 
Kit, LS (Large Scale) 

Contents: 

 2X Hybridization Buffer 
(3 x vial 1) 

 Hybridization 
Component A  
(3 x vial 2) 

 Alignment Oligo1  
(3 x vial 3) 

 305 hybridizations using 385K arrays 

 488 hybridizations using 4x72K arrays 

 122 hybridizations using 2.1M arrays 

 306 hybridizations using 3x720K arrays 

05 583 934 001 

NimbleGen Sample 
Tracking Control Kit 

Contents: 

Sample Tracking Controls2 

 480 hybridizations using 4x72K arrays 

 300 hybridizations using 3x720K arrays 

05 223 512 001 



Chapter 1. Before You Begin 

 
 

 
 NimbleGen Arrays User’s Guide: DNA Methylation Arrays v7.1  10 

Component 
Package Size /  
Process Quantity 

Catalog No. 

NimbleGen Wash Buffer Kit 

Contents: 

 10X Wash Buffer I  
(2 x vial 1) 

 10X Wash Buffer II  
(vial 2) 

 10X Wash Buffer III  
(vial 3) 

 DTT (2 x vial 4) 

 Nuclease-free Water  
(3 x vial 5) 

20 washes (processing up to 12 slides per wash) 05 584 507 001 

NimbleGen Array 
Processing Accessories 

Contents: 

 Slide Rack 

 Wash Tanks 

 Slide Containers 

 05 223 539 001 

1 The Alignment Oligo is a mixture of Cy3 and Cy5 labeled 48 mer oligonucleotides that hybridize to alignment 
features on NimbleGen arrays. It is required for proper extraction of array data from the scanned image.  

2 Twelve Sample Tracking Controls (STCs) are provided. Each STC is a Cy3-labeled 48 mer oligonucleotide. When a 
unique STC is added to each sample before hybridization to a multiplex array, the STC can be used to confirm that 
the correct sample was hybridized to each array. 

Reagents/Consumables Purchased from Other Vendors 

Component Supplier Package Size Catalog No. 

β-Mercaptoethanol Sigma Aldrich 25 ml M3148 

Absolute Ethanol Sigma Aldrich 500 ml E702-3 

Compressed Nitrogen or 
Argon Gas (for cleaning 
array surface)* 

Multiple Vendors    

192 tips F148412 CP10 Pipette Tips 
(for 4x72K arrays) 

Gilson 

960 tips F148312 

192 tips F148414 CP100 Pipette Tips 
(for 385K, 2.1M, and 3x720K 
arrays) 

Gilson 

960 tips F148314 

Isopropanol Sigma Aldrich 500 ml I-9516 

Water: reagent grade, ACS, 
nonsterile, type 1 

VWR 2.5 gallon RC915025 

Cotton Swabs Multiple Vendors   

* Roche NimbleGen recommends using a compressed gas nozzle to gently blow compressed nitrogen or argon gas 
across arrays to remove any dust or debris. The use of canned aerosol compressed air for this purpose is not 
recommended and could compromise array and data quality. 
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Technical Support 

If you have questions, contact your local Roche Microarray Technical Support. Go to 
www.nimblegen.com/arraysupport for contact information. 

Conventions Used in This Manual 

Text Conventions 

To impart information that is consistent and memorable, the following text conventions are 
used in this User’s Guide: 

Convention Description 

Numbered listing Steps in a procedure that must be performed in the order listed. 

Italic type, blue Points to a different chapter in this User’s Guide to consult or to a 

web site. 

Italic type Identifies the names of controls (checkboxes, option buttons, etc.) 

in dialog boxes, windows, or message boxes in software. 

Bold type Identifies buttons and menu names when operating software. 

Underscore and brackets A placeholder for information such as in the actual name of a 

directory in a path is enclosed in brackets, e.g. <install path>. 

Placeholders (for file names, numbers, dates, etc.) are separated 

by an underscore ( _ ), e.g. <Barcode>_<User Text>_<Laser 

WL>. 

Symbols 

The following types of notices may be used in this manual to highlight important information 
or to warn the operator of a potentially dangerous situation: 

Symbol Description 

 
Important Note. Used to bring your attention to important annotation. 

 

Information Note: Designates a note that provides additional information concerning the current topic 
or procedure. 

 

 

http://www.nimblegen.com/arraysupport/
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Chapter 2. Sample Preparation & QC 

Chapter 2 describes sample requirements and the sample QC protocol for NimbleGen DNA 
Methylation experiments. 

Sample Requirements 

 High-quality DNA generated using the MeDIP (methylated DNA immunoprecipitation) 
method is required to obtain optimally labeled samples for array hybridization. The 
NimbleGen sample preparation protocol for DNA methylation is available upon request 
from Roche Microarray Technical Support. 

 Roche NimbleGen recommends starting with the following sample amounts for each 
hybridization. If your experimental (IP) sample quantity is less than the amount listed, 
amplify the experimental (IP) and control (input) samples using the Sigma GenomePlex 
Complete WGA 2 Kit (Catalog No. WGA2-50RXN) before labeling. Then purify samples 
using the Qiagen QIAquick PCR Purification Kit (Catalog No. 28106). 

 
The success of the IP reaction depends on the amount of 5-methyl cytidine 
antibody used. Amounts should be determined empirically by titration. 

Starting Sample Amount 
Recommendations 

385K  
Array 

Each Sample 
for a 4x72K 

Array 

2.1M  
Array 

Each Sample 
for a 3x720K 

Array 

Experimental (IP) Sample 1.5 μg 1.5 μg 3.5 μg 1.5 μg 

Control (Input) Sample 1.5 μg 1.5 μg 3.5 μg 1.5 μg 
     

 For optimal results, samples should meet the following criteria: 

• A significant majority of the DNA ≥  200 nucleotides in size. 

• A concentration of approximately 250 ng/μl to 1,000 ng/μl in nuclease-free water or 
1X TE buffer (10 mM Tris-HCl and 0.1 mM EDTA, pH 7.5 - 8.0). 

• An A260/A280 ≥ 1.7 and A260/A230 ≥ 1.6. 

Sample QC 

1. Transfer 200 ng of each sample to a sterile microcentrifuge tube. Store the remainder of 
your sample set at -20°C until required for labeling. 

2. Analyze the samples using the Agilent Bioanalyzer and RNA 6000 Nano Assay Reagent Kit 
or by agarose gel electrophoresis. 

3. Review Bioanalyzer traces (Figure 2 and Figure 3) or agarose gels (Figure 4) for sample 
degradation. Degraded samples detected using the Bioanalyzer appear as significantly 
lower intensity traces with the main peak area shifted to the left with typically more noise 
in the trace. 

 
Samples exhibiting degradation should not be carried through labeling and 
hybridization due to the risk of poor results. 
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Figure 2: Examples of Bioanalyzer Traces of Nondegraded Samples 

 

Figure 3: Example of Bioanalyzer Trace of a Degraded Sample 
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Figure 4: Example of Agarose Gel Electrophoresis for Samples of Good Quality 
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Chapter 3. Sample Labeling 

Chapter 3 describes how to label your experimental (IP) and control (input) samples using a 
NimbleGen Dual-Color DNA Labeling Kit. Be aware of the following when using the 
NimbleGen Dual-Color Labeling Kit: 

 Aliquot dNTPs and Cy primers into single-use amounts. 

 5 M NaCl could precipitate. Vortex or heat if necessary. 

Most researchers performing MeDIP include a control (input) sample. However, some 
researchers will perform another two-color array experiment, running the control (input) 
sample against a non-specific binding sample to test for false positives. 

 Control (input) sample: A small aliquot of the starting DNA is carried through the 
labeling protocol and used as a reference sample. 

 Non-Specific Binding (NSB) sample: NSB samples are IP reactions carried out where the 
primary antibody (anti-5-methyl-cytosine here) is omitted or substituted with 
pre-immune or non-specific immunoglobulin G. NSB samples are used to test the level of 
enrichment specific to the IP antibody. 

Potential arrays run in parallel if using NSB samples are as follows: 

• Test array = Cy5-labeled experimental (IP) sample/Cy3-labeled control (input) 
sample 

• False positive array = Cy5-labeled NSB sample/Cy3-labeled control (input) sample 

Pairs of samples intended for hybridization to the same array should be labeled in parallel using 
Cy3-Random and Cy5-Random Nonamers from the same kit (or multiple kits from the same 
lot). Roche NimbleGen recommends labeling experimental (IP) samples with Cy5 and control 
(input) samples with Cy3. 

1. Prepare the following solution in a 1.5 ml microfuge tube: 

Random Primer Buffer 
All Array 
Formats 

Notes 

 Random Primer Buffer (vial 2)  998.25 μl 

 β-Mercaptoethanol*  1.75 μl 

 Total  1 ml 

Prepare fresh buffer each time primers are 
resuspended.  

* Do not use bottles of β-Mercaptoethanol that have been opened for more than 6 months. 

 

2. Briefly centrifuge Cy3-Random and Cy5-Random Nonamers (vials 3 and 4, respectively) 
because some of the product could have dislodged during shipping. Dilute the primers in 
462 μl each of Random Primer Buffer with β-Mercaptoethanol. Aliquot to 40 μl individual 
reaction volumes in 0.2 ml thin-walled PCR tubes and store at -20°C, protected from light. 

 
Do not store diluted primers longer than 4 months. 
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3. Assemble the experimental (IP) and control (input) samples in separate 0.2 ml thin-walled 
PCR tubes. 

Component 
385K, 4x72K,  

and 3x720K Arrays 
2.1M Arrays 

 
Experimental 
(IP) Sample 

Control (Input) 
Sample 

Experimental  
(IP) Sample 

Control (Input) 
Sample 

Sample prepared in 
Chapter 2 

1 μg 1 μg 
1 μg (in each  
of 3 tubes)* 

1 μg (in each 
of 3 tubes)* 

Diluted Cy3-Random 

Nonamers from step 2 
 40 μl  

40 μl  
(per tube) 

 Diluted Cy5-Random 
Nonamers from step 2 

40 μl  40 μl (per tube)  

 Nuclease-free Water 
(vial 1) 

To volume (80 μl) To volume (80 μl) 
To volume (80 μl)  

(per tube) 
To volume (80 μl) 

(per tube) 

 Total 80 μl 80 μl 
80 μl  

(per tube) 
80 μl 

(per tube) 

*  2.1M arrays require three labeling reactions each of experimental (IP) and control (input) sample per slide. 

Therefore, for 2.1M arrays, assemble three separate 0.2 ml thin-walled PCR tubes with each containing 1 μg 

DNA for each experimental (IP) and control (input) sample. Experimental (IP) and control (input) sample pairs 

intended for hybridization to the same 2.1M array should be labeled in parallel. If labeled DNA yields are 

consistently high, the number of labeling reactions for a 2.1M array can be reduced from 3 to 2 reactions 

(34 μg labeled DNA per sample is required for each array). 

 

4. Heat-denature samples in a thermocycler at 98°C for 10 minutes. Quick-chill in an 
ice-water bath for 2 minutes. 

 
Quick-chilling after denaturation is critical for high-efficiency labeling. 

5. Prepare the following dNTP/Klenow master mix for each sample prepared in step 4. 

 
Keep all reagents and dNTP/Klenow master mix on ice. Do not vortex after 
addition of Klenow. 

dNTP/Klenow Master Mix: Recipe per Sample All Array Formats 

 10 mM dNTP Mix (vial 6)  10 μl 

 Nuclease-free Water (vial 1)  8 μl 

 Klenow Fragment (3'->5' exo-) 50 U/μl (vial 5)  2 μl 

 Total  20 μl 

  

6. Add 20 μl of the dNTP/Klenow master mix prepared in step 5 to each of the denatured 
samples prepared in step 4. Keep on ice. 
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All Array Formats 

Component Experimental  
(IP) Sample 

Control (Input) 
Sample 

 Reaction volume from step 4  80 μl  80 μl 

 dNTP/Klenow Master Mix from step 5  20 μl  20 μl 

 Total  100 μl  100 μl 

   

7. Mix well by pipetting up and down 10 times. 

 
Do not vortex after addition of Klenow. 

8. Quick-spin to collect contents in bottom of the tube. 

9. Incubate for 3 hours at 37°C in a thermocycler with heated lid, protected from light. 

10. Stop the reaction by addition of the Stop Solution (0.5 M EDTA). 

All Array Formats 

Component Experimental  
(IP) Sample 

Control (Input) 
Sample 

 Reaction volume from step 6  100 μl  100 μl 

 Stop Solution (0.5 M EDTA) (vial 7)  10 μl  10 μl 

 Total  110 μl  110 μl 

   

11. Add 5 M NaCl to each tube. 

All Array Formats 

Component Experimental  
(IP) Sample 

Control (Input) 
Sample 

 Reaction volume from step 10  110 μl  110 μl 

 5 M NaCl (vial 8)  11.5 μl  11.5 μl 

 Total  121.5 μl  121.5 μl 

   

12. Vortex briefly, spin, and transfer the entire contents to a 1.5 ml tube containing 
isopropanol. 

All Array Formats 

Component Experimental  
(IP) Sample 

Control (Input) Sample

 Reaction volume from step 11  121.5 μl  121.5 μl 

 Isopropanol  110 μl  110 μl 

 Total  231.5 μl  231.5 μl 

   

 
Up to 3 reactions containing the same sample can be combined in a 1.5 ml tube and 
precipitated together. If combined, be sure to scale the isopropanol volume 
appropriately. 
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13. Vortex well. Incubate for 10 minutes at room temperature, protected from light. 

14. Centrifuge at 12,000 x g for 10 minutes. Remove supernatant with a pipette. Pellet should 
be pink (Cy3) or blue (Cy5) depending on the dye. 

15. Rinse pellet with 500 μl 80% ice-cold ethanol. Dislodge pellet from tube wall by pipetting a 
few times. 

16. Centrifuge at 12,000 x g for 2 minutes. Remove supernatant with a pipette. 

17. Dry contents in a DNA vacuum concentrator on low heat until dry (approximately 5 
minutes), protected from light. 

18. STOP POINT: Proceed to step 19, or store labeled samples at -20°C (up to 1 month), 
protected from light. 

19. Spin tubes briefly prior to opening. Rehydrate each pellet in 25 μl Nuclease-free Water 
(vial 1) per reaction. 

20. Vortex for 30 seconds and quick-spin to collect contents in bottom of the tube. Continue 
to vortex or let sit at room temperature, protected from light, for approximately 5 minutes 
or until the pellet is completely rehydrated, then vortex again and quick-spin. 

21. Quantitate each sample using the following formula: 

Concentration (μg/ml) = A260 x 50 x Dilution Factor 

 
If using a NanoDrop Spectrophotometer, refer to the manufacturer’s instructions 
to ensure accurate quantitation. 

22. Based on the concentration, calculate the volume of the experimental (IP) sample and 
control (input) sample required for each hybridization per the following table and 
combine both experimental (IP) and control (input) samples in a 1.5 ml tube: 

Sample Requirements 
385K  
Array 

4x72K  
Array 

2.1M  
Array 

3x720K 
Array 

Experimental (IP) Sample 6 μg 4 μg 34 μg* 15 μg 

Control (Input) Sample 6 μg 4 μg 34 μg* 15 μg 

*  If the 34 μg was not obtained from the 3 labeling reactions, the hybridization can be performed with as little 
as 24 μg. 

 

23. Dry contents in a DNA vacuum concentrator on low heat, protected from light. 

24. STOP POINT: Proceed to Chapter 4, or store labeled samples at -20°C (up to 1 month), 
protected from light. 
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Chapter 4. Hybridization & Washing 

Chapter 4 describes the NimbleGen protocol for sample hybridization and washing. Be aware 
of the following: 

 The hybridization protocol requires a NimbleGen Hybridization System. Refer to its User’s 
Guide for specific instructions on its use. 

 The hybridization protocol requires adhering a NimbleGen mixer to the microarray slide. 
Refer to the package label to identify the mixer design. Some instructions in the protocol 
are specific to the mixer design. 

 The Alignment Oligo and Sample Tracking Controls (STCs) provided in the NimbleGen 
Hybridization and Sample Tracking Control Kits, respectively, are labeled with Cy dyes, 
which are sensitive to photobleaching and freeze-thawing. After thawing stock tubes for 
the first time, aliquot the Alignment Oligo and STCs into single-use volumes and freeze at 
-20°C. Protect tubes from light. 

Step 1. Prepare Samples 

1. Set the Hybridization System to 42°C. With the cover closed, allow at least 3 hours for the 
temperature to stabilize. 

 
Be aware that the temperature of the Hybridization System could fluctuate during 
stabilization. 

2. Resuspend the dried sample pellet in Sample Tracking Control according to the following 
table. Use a unique STC to resuspend each sample to be hybridized. Record which STC is 
used for each sample. 

 
If you are not using Sample Tracking Controls, resuspend the dried sample pellet 
in the equivalent volume of water. 

Component 
385K 
Array 

Each Sample for 
a 4x72K Array 

2.1M 
Array 

Each Sample for 
a 3x720K Array 

Reagent for 
resuspension 

VWR 
Water 

Sample Tracking 
Control 

VWR 
Water 

Sample Tracking 
Control 

Volume to add to 
Cy-labeled 

Sample from step 
23 in Chapter 3 

5 μl 3.3 μl 12.3 μl 5.6 μl 

     

3. Vortex well and spin to collect contents in bottom of the tube. 

4. Using components from a NimbleGen Hybridization Kit, prepare the hybridization 
solution master mix according to the following table. For 4x72K and 3x720K arrays, the 
amount listed is sufficient to hybridize all arrays on one slide. To hybridize multiple slides, 
adjust the amounts accordingly. 
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Hybridization Solution 
Master Mix to Hybridize 
a Single Slide 

385K 
Array 

4x72K 
Array 

2.1M  
Array 

3x720K 
Array 

2X Hybridization Buffer  
(vial 1) 

11.8 μl  29.5 μl  29.5 μl  35 μl 

Hybridization Component A  
(vial 2) 

 4.7 μl  11.8 μl  11.8 μl  14 μl 

Alignment Oligo  
(vial 3) 

 0.5 μl  1.2 μl  1.2 μl  1.4 μl 

Total  17 μl  42.5 μl  42.5 μl  50.4 μl 

 

5. Add the appropriate amount of hybridization solution to each sample pair according to 
the following table: 

Component 
385K 
Array 

Each Sample 
Pair for a 

4x72K Array 

2.1M 
Array 

Each Sample 
Pair for a 

3x720K Array 

Resuspended sample 
from step 2 

 5 μl  3.3 μl  12.3 μl  5.6 μl 

Hybridization solution 
from step 4 

 13 μl  8.7 μl  31.7 μl  14.4 μl 

Total  18 μl  12 μl  44 μl  20 μl 

     

6. Vortex well (approximately 15 seconds) and spin to collect contents in bottom of the tube. 
Incubate at 95°C for 5 minutes, protected from light. 

7. Place tubes at 42°C (in the Hybridization System sample block or heat block) for at least 5 
minutes or until ready for sample loading. Vortex and spin prior to loading. 

Step 2. Prepare Mixers 

1. Locate the appropriate mixer. Remove from its package. 

 
For best results, use a compressed gas nozzle to gently blow compressed nitrogen 
or argon gas across the mixer and slide to remove any dust or debris. The use of 
canned aerosol compressed air for this purpose is not recommended and could 
compromise array and data quality. 

 
Load samples within 30 minutes of opening the vacuum-packaged mixer to 
prevent the formation of bubbles during loading and/or hybridization. 

Array Format Mixer 

385K array X1 mixer 

4x72K array X4 mixer 

2.1M array HX1 mixer 

3x720K array HX3 mixer 

  

2. Position the Precision Mixer Alignment Tool (PMAT) with its hinge on the left. Open the 
PMAT (Figure 5). 
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3. Snap the mixer onto the two alignment pins on the lid of the PMAT with the tab end of the 
mixer toward the inside hinge and the mixer’s adhesive gasket facing outward (Figure 5). 

4. While pushing back the plastic spring with a thumb, place the slide in the base of the 
PMAT so that the barcode is on the right and the corner of the slide sits against the plastic 
spring. The NimbleGen logo and barcode number should be readable. Remove your 
thumb and make sure the spring is engaging the corner of the slide and the entire slide is 
registered to the edge of the PMAT to the rightmost and closest to you. In addition, be sure 
that the slide is lying flat against the PMAT. Gently blow compressed nitrogen or argon gas 
across the mixer and slide to remove dust. 

 
Take care to align the slide correctly in the PMAT. Incorrectly aligned slides may 
result in inaccurate attachment of the mixer and may affect the array features, or 
may not fit well into the Mixer Disassembly Tool used to remove the mixers after 
hybridization. 

5. Using forceps, remove the backing from the adhesive gasket of the mixer and close the lid 
of the PMAT so that the gasket makes contact with the slide. 

6. Lift the lid by grasping the long edges of the PMAT while simultaneously applying pressure 
with a finger through the window in the lid of the PMAT to free the mixer-slide assembly 
from the alignment pins. 

 

 

 
 

Figure 5: PMAT with HX3 Mixer and Slide. For photographic purposes only, blue coloring was used to 
show the location of the mixer’s hybridization chambers. The hybridization chambers of the mixer you receive 
will not be blue.  

Alignment
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Plastic  
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7. Remove the mixer-slide assembly from the PMAT. 

8. Place the mixer-slide assembly on the back of a 42°C heating block for 5 minutes to 
facilitate adhesion of the mixer to the slide. 

9. Rub the Mixer Brayer over the mixer with moderate pressure to adhere the adhesive gasket 
and remove any bubbles. For X1 and HX1 mixers, start in the center of the array and rub 
outwards. For X4 and HX3 mixers, first use a corner of the Mixer Brayer to rub the borders 
between the arrays and then rub around the outside of the arrays. The adhesive gasket will 
become clear when fully adhered to both surfaces. 

10. Place the mixer-slide assembly in the slide bay of the Hybridization System. 

Step 3. Load & Hybridize Samples 

1. Refer to the appropriate diagram below when loading sample: 

B
ar

co
de

Fill Port

Vent Port  

Figure 6: X1 Mixer and Slide for a 385K Array 
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A01 A02A03 A04

 

Figure 7: X4 Mixer and Slide for a 4x72K Array 
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Figure 8: HX1 Mixer and Slide for a 2.1M Array 
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Figure 9: HX3 Mixer and Slide for a 3x720K Array 

2. Keep the following in mind before loading sample: 

• Leave residual volume in the sample tube to avoid bubbles. The volumes listed in the 
table below account for this additional amount. 

• After aspirating the designated sample volume, inspect the pipette tip for air bubbles. 
Dispense and reload the pipette if bubbles exist. 

Keep the following in mind when loading sample: 

• Keep the pipette tip perpendicular to the slide to avoid possible leakage at the fill port. 

• Apply gentle pressure of the tip into the port to ensure a tight seal while loading the 
sample. 
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Component 385K Array 4x72K Array 2.1M Array 3x720K Array 

Sample Loading Volume 16 μl 8 μl 41 μl 18 μl 

Pipette Tip CP100 CP10* CP100 CP100 

* The CP10 tip is thin and flexible. Place the thumb and forefinger of your free hand on the tip to guide it into 
the port. 

 

3. Using the appropriate Gilson Microman pipette, slowly dispense the appropriate sample 
volume into the fill port. Load samples and seal mixer ports as described below for each 
array format: 

• For 385K, 2.1M, and 3x720K arrays: 

a. Load sample into the fill port. Dry any overflow from the fill and vent ports with a 
cotton swab after loading the array. For 3x720K arrays, it is not unusual for small 
bubbles to form in the corners of the mixer-slide assembly during loading. These 
bubbles will dissipate upon mixing and will not compromise the data. 

b. Use one mixer port seal to cover the fill port and another to cover the vent port 
on X1 or HX1 mixers. Use one mixer port seal to cover both the fill and vent 
ports on HX3 mixers, filling and sealing one chamber at a time. Press the mixer 
port seal, using uniform pressure across the seal to adhere. 

c. Use forceps to press the mixer port seal around the fill and vent ports to ensure it 
is adhered in those areas. 

• For 4x72K arrays: 

a. Load sample into the A01 fill port. Dry any overflow from the fill and vent ports 
with a cotton swab after loading. Repeat loading samples into the A02 - A04 fill 
ports, using a fresh cotton swab for drying the ports for each array. 

b. Use one mixer multi-port seal to cover all fill and vent ports on X4 mixers. Press 
the mixer multi-port seal, using uniform pressure across the seal to adhere. 

c. Use forceps to press the mixer multi-port seal around the fill and vent ports to 
ensure it is adhered in those areas. 

4. Close the bay clamp. 

5. Turn on the Mixing Panel on the Hybridization System, set the mix mode to B, and press 
the mix button to start mixing. Confirm that the Hybridization System recognizes the slide 
in each occupied bay (its indicator light becomes green). 

6. Approximately 10 minutes after starting the Hybridization System: 

• Ensure the mix mode is set to B. 
• Ensure a green light is displayed for all occupied stations. 

7. Hybridize sample at 42°C to the array(s) for 16 - 20 hours. 
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Step 4. Wash Hybridized Arrays 

 
To ensure high quality data, it is important to proceed through all the washing and 
drying steps without interruption. The NimbleGen Microarray Dryer dries up to 24 
slides at a time. If using a microarray dryer that dries one slide at a time, wash only one 
slide at a time. 

1. Locate the components of the NimbleGen Wash Buffer Kit and NimbleGen Array 
Processing Accessories (refer to page 8). 

 
Prior to the first use of the Wash Buffer Kit, reconstitute the DTT. In a fume hood, 
prepare 1 M DTT solutions by adding 1.2 ml of water (vial 5) to each tube of dry 
DTT (vial 4). After reconstitution, store the 1 M DTT solutions at -15ºC to -25ºC. 

2. Before removing the mixer-slide assemblies from the Hybridization System, prepare 
Washes I, II, and III according to the following tables. Note that you prepare two 
containers of Wash I. 

Washing Multiple Slides 
Wash I 

(user-supplied dish1) 
Washes I, II, and III 

(wash tank 
2) 

 VWR Water  243 ml  243 ml 

10X Wash Buffer I, II, or III (vial 1, 2, or 3)  27 ml  27 ml 

 1 M DTT solution from step 1  27 μl  27 μl 

 Total  270 ml  270 ml 

Washing One Slide 
Wash I 

(user-supplied dish1) 
Washes I, II, and III 
(slide container 

2) 

 VWR Water  243 ml  24.3 ml 

10X Wash Buffer I, II, or III (vial 1, 2, or 3)  27 ml  2.7 ml 

 1 M DTT solution from step 1  27 μl  2.7 μl 

 Total  270 ml  27 ml 

1 Ensure that this dish is shallow and wide enough to accommodate the mixer-slide assembly loaded in the 
Mixer Disassembly Tool. This dish must also be small enough to ensure that the Mixer Disassembly Tool is 
completely submerged in the wash solution. 

2 If washing multiple slides, prepare the washes in the wash tanks. If washing only one slide, prepare the 
washes in the slide containers. 

 

3. To facilitate the removal of the mixer, heat the shallow dish containing Wash I to 42°C. 
Roche NimbleGen recommends measuring the temperature of Wash I at every use. Keep 
the remaining three wash solutions at room temperature. 

4. Insert the Mixer Disassembly Tool into the shallow dish containing warm Wash I. If you 
will be washing multiple slides, insert a slide rack into the wash tank containing Wash I at 
room temperature. 

5. Remove a mixer-slide assembly from the Hybridization System and load it into the Mixer 
Disassembly Tool immersed in the shallow dish containing warm Wash I. 
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Do not allow the mixer-slide assembly to cool before removing the mixer. Keep 
power on to the Hybridization System’s heat block and mixer system during 
mixer-slide disassembly, and transfer each mixer-slide assembly one at a time to 
Wash I for immediate removal of the mixer. 

6. With the mixer-slide assembly submerged, carefully peel the mixer off the slide. It is 
important to hold the Mixer Disassembly Tool flat while removing the mixer and to avoid 
any horizontal movement or scraping with the mixer across the slide. Do not touch the 
array surface of the slide. 

 
The mixer is extremely flexible. Peel the mixer off slowly to avoid breaking the 
slide. 

 

Figure 10: Using the Mixer Disassembly Tool to Remove a Slide from a Mixer 

7. Working quickly, discard the mixer and remove the slide from the Mixer Disassembly 
Tool. 

8. Gently agitate the slide for 10 - 15 seconds in the shallow dish containing warm Wash I to 
quickly remove the hybridization buffer. 

 
It is important for achieving good array uniformity to quickly and evenly wash the 
hybridization buffer off the slide surface as soon as the mixer is removed. 

9. If washing multiple slides, transfer the slide with the barcode at the top into a slide rack 
(Figure 11) in the wash tank that contains Wash I. If washing one slide, transfer the slide 
into a slide container that contains Wash I. Agitate vigorously for 10 - 15 seconds. 

 
Slide rack users: To ensure high quality data, make sure the microarray area of 
the slide remains wet at all times during all wash steps. 

 

Figure 11: Insert Slides with the Barcode at the Top into the Slide Rack 
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If you are using a NimbleGen Microarray Dryer or other microarray dryer that 
dries multiple slides at a time, repeat steps 4 - 9 until you have removed the mixer 
from all slides to wash. Load each slide into the slide rack with the array facing the 
same direction. 

10. Wash for an additional 2 minutes in Wash I with vigorous, constant agitation. If washing 
multiple slides, move the rack up and down with enough agitation to make foam appear. If 
washing one slide, shake the slide container at least 20 times every 10 seconds. 

 
At several times during the wash, rock the wash tank so the wash solution covers 
and cleans the top of the slide(s). 

11. Quickly blot the rack, or edges of the slide if only washing one slide, several times using 
paper towels to minimize buffer carryover. Transfer the slide(s) to Wash II and wash for 
1 minute with vigorous, constant agitation. If washing multiple slides, rock the wash tank 
so the wash solution covers and cleans the tops of the slide(s). 

 
Do not allow slides to dry between wash steps. 

12. Transfer the slide(s) to Wash III and wash for 15 seconds with vigorous, constant 
agitation. If washing multiple slides using the slide rack, rock the wash tank so the wash 
solution covers and cleans the tops of the slide(s). 

13. Remove the slide(s) from Wash III. Spin dry in a NimbleGen Microarray Dryer or other 
microarray dryer per the manufacturer’s recommendation. For a NimbleGen Microarray 
Dryer, the recommended drying time is 2 minutes (120 seconds). 

14. Remove the slide(s) from the NimbleGen Microarray Dryer or other microarray dryer. 
Blot dry the edges to remove any residual moisture. 

 
When not in use, store the dried slide in its original slide case in a dark desiccator. 

15. Proceed immediately to the steps for scanning the array(s) in Chapter 5. 
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Chapter 5. Two-Color Array Scanning 

Chapter 5 describes the protocol for scanning two-color NimbleGen arrays with the MS 200 
Microarray Scanner and the MS 200 Data Collection Software. 

Before starting these procedures, review the information in the NimbleGen MS 200 Microarray 
Scanner Operator’s Manual (available at www.nimblegen.com/products/instruments/ under 
Literature) or the online help available via the MS 200 Data Collection Software. These 
materials provide more detailed instructions on using the scanner, control unit (computer), 
and software than provided in this chapter. 

 
Keep arrays in a dark desiccator until you are ready to scan them. When handling 
slides, wear powder-free gloves and use care to touch only the slide’s edges. 

Step 1. Start Control Unit, Turn on Scanner & Load Slides 

1. Start the control unit and log into your user account as msOperator or other account as set 
up by your system administrator. 

Account: msOperator 
Password: 1-msOperator 

2. Turn on the scanner using the power switch on the left side. 

3. Using a compressed gas nozzle, gently blow compressed nitrogen or argon gas across the 
slide to remove any dust or debris from the array. Do not use canned aerosol compressed 
air for this purpose. 

4. Insert slides into the Slide Magazine as described in Figure 12. Numbered slots provide 
spacing for inserting slides. 

 

Figure 12: Inserting Slides into the Slide Magazine 

5. Press the insert/eject magazine button on the scanner to open the stacker cover. Insert the 
slide magazine with loaded slides, aligning the slot on the slide magazine’s side to join with 
the rail profile inside the scanner. The lowering of the slide magazine is interrupted by a 
mechanical hold point. Apply gentle pressure to complete insertion. Press the insert/eject 
magazine button to close the stacker cover (Figure 13). The initialization process starts, 
checking the slide magazine to determine which slots are occupied. 

http://www.nimblegen.com/products/instruments/
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Figure 13: Inserting the Slide Magazine into the Scanner 

Step 2. Start the Software & Turn on the Lasers 

1. Double-click the NimbleGen MS200 icon to launch the MS 200 Data Collection Software. 
Make sure that the software has completely loaded before continuing. 

2. Click the Green Laser and Red Laser buttons in the Laser Control (Figure 14) to switch on 
the lasers. Allow lasers to warm for 10 minutes. 

 

Figure 14: Top of Data Collection Workspace, showing Scan Control, Laser Control, and Image 

Control 

3. Review the Magazine Control (Figure 15) in the Data Collection Software. Ensure that a 
green box appears in the Slide Present field for each slide loaded into the slide magazine. 
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Figure 15: Magazine Control, Parameter Control, and File Setting Control 

Step 3. Set Scan Parameters Using the Software 

1. Use the Parameter Control (Figure 15) to set the parameters to use when scanning: 

a. To open the Parameter Control if not displayed, go to the row of a slide to scan in the 
Magazine Control and click its Open Parameter Control button ( ) to display the 
Parameter Control. 

b. Do not adjust the following default parameters: 

• Slide type 
• Channel 1 and Channel 2 
• Laser Intensity 1 and Laser Intensity 2 
• for slide nr: 2 cycle: 1 only 

c. Adjust the following default parameters if necessary:  

• Resolution  
• Speed/Sensitivity  
• Autogain  

d. To save any changes to the settings, click Apply. 

e. (Optional) Click Save to save settings to a parameters file, which allows the settings to 
be applied to other slides. 

f. (Optional) To process the slide multiple times using the same or different parameters, 
create up to 12 cycles. 
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To create a cycle, close the Parameter Control by clicking the Close Parameter 
Control button ( ). Go to the slide row in the Magazine Control, right-click, and 
select Add Cycle. Open the Parameter Control. Then specify and save parameters for 
the cycle as described above (1b - 1e). 

2. Use the File Settings Control (Figure 15) to specify image file settings: 

a. To open the File Settings Control if not displayed, go to the row of a slide to scan in 
the Magazine Control and click its Open Parameter Control button ( ) (Figure 15). 
In the Parameter Control, click the Open/Close File Settings button ( ) to open the 
File Settings Control. 

b. Choose the Single-TIFF option button to generate one image file in Tagged Image File 
Format (TIFF, .tif) per channel. 

c. If necessary, change the path to which the images files will be saved. The default path 
is E:\Data\NimbleGen MS 200. To change the path, click Browse to open a dialog box 
to specify a location in the directory and click OK to confirm. 

d. Use the annotation list to add or change annotations to include in file names. Click an 

annotation in the left list box and then click the right arrow button ( ) to add to the 
right list box. 

If you will be using NimbleScan software for data analysis, specify and order the 
annotations as follows: 

<Barcode>_<User Text>_<Laser WL>.tif 

where “WL” means wavelength. To change the order of the annotations, select the 
annotation and click the Up or Down button. For “User Text,” make sure to type the 
text in the User Text field. 

The Filename Preview text box of the Parameter Control displays the entire naming 
convention of the image file (.tif). 

e. Click Apply to confirm settings. 

f. (Optional) To save the file settings to a file, click Save in the Parameters Control 
(Figure 15). 

3. Use the Area Definition Control (Figure 16; denoted as Scan Areas in the software 
interface) to set scan, barcode, and autogain areas. 

a. To open the Area Definition Control if not displayed, in the Parameter Control, click 
the Open/Close Area Definition Control button ( ) (shown on the right side of 
Figure 15 above the Scan Areas label in the software interface). Figure 16 shows the 
components of the Area Definition Control. 
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Figure 16: Components of the Area Definition Control 

b. Ensure the following are selected: 

• Barcode area checkbox 

• Autogain area checkbox, if the Autogain checkbox was selected in the Parameter 
Control (Figure 15) 

• Single Area option - this is the preferred option when scanning single and 
multiplex NimbleGen arrays. For multiplex arrays, you will use NimbleScan 
software’s burst functionality to create individual image files for multiplex arrays. 

c. Review and if necessary adjust the scan area: 

• For NimbleGen 2.1M and 3x720K arrays, use the default selection for the scan 
area. 

• (Optional) For NimbleGen 385K and 4x72K arrays, reduce the scan area, which 
will reduce the scan time. To define the scan area, download and use area files 
available at www.nimblegen.com/scanner/ under Download. These files identify 
scan areas that are specific for NimbleGen 385K or 4x72K arrays. For instructions 
on how to use area files or how to manually adjust the scan area, refer to the 
NimbleGen MS 200 Microarray Scanner Operator’s Manual. 

• If desired, click Save to save settings to an area file for future use. 

d. Review and if necessary adjust the autogain area. 

http://www.nimblegen.com/scanner/
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To adjust the autogain area, position the mouse pointer inside the respective rectangle 
and click to enable the move cursor. Drag the rectangle to the desired array location 
and about 10 mm from the edge of the default scan area. Size the rectangle by 
dragging the side and corner handles (3 mm x 3 mm to 22 mm x 22 mm). Click Apply 
to confirm your settings. 

 385K Arrays 4x72K Arrays 2.1M and 3x720K Arrays 

    

Figure 17: Examples of Autogain Areas for NimbleGen Arrays 

4. Repeat the instructions above for each slide to process during the experiment. 

If you saved parameter file(s) and area file(s), click Load in the Parameter Control or Area 
Definition Control, respectively, to select a file and then click Apply to confirm your 
selection. 

Step 4. Scan the Slides 

1. Click the Start/Stop Scan button ( ) in the Scan Control (Figure 18). 

2. When prompted, specify the folder and file naming to save the session file. 

The scan process is then initiated. The Parameter Control and Area Definition Control 
close. The Image View, Slide View, and Spot View open (Figure 18), and the Scan Control 
shows the current task that is being performed above the progress bar. 
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Figure 18: Example of a Run Time Window 

3. (Optional) To manually adjust the PMT gain while scanning at 5 μm or higher resolution: 

a. Use the Gain 1 and Gain 2 spin boxes that appear in the Scan Control (Figure 18) to 
adjust the gain. 

 

b. Click Show Histogram in the Image Control (Figure 18) to view the histogram. Use 
the zoom feature (magenta box in the Slide View, Figure 20), to select where to view 
the histogram. 

 

 
The best data are achieved when the red and green curves are superimposed 
or as close as possible to one another. If the red curve is above the green curve, 
lower the red curve (Channel 2). The curves should level out near 3 log10. 
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Figure 19: Histogram Window 

c. Record the final gain settings to use to scan the slide again. 

4. After the scanning experiment is completed, the light in the upper-left corner of the 
insert/eject magazine button on the scanner becomes green. The scanner unlocks its 
stacker cover, and you can remove the slide magazine. 

Step 5. Review Scanned Images 

1. Once the scan of a slide is completed, a blue Displays Images button ( ) appears in the 
Display Images field of the Magazine Control (Figure 15). Move the mouse pointer over 
the button to display the directory location and file name of the acquired image. Click the 
blue Displays Images button ( ) to display the image (both images) in the Image View. 

2. To view a small region of the array and to select where to view the histogram (Figure 20), 
reduce the size of the magenta box that outlines the slide image in the Slide View so that 
the magenta box surrounds the area of interest. The area of interest will appear in the 
Image View. Click Show/Hide Histogram to display the histogram. 

   

Figure 20: Example Window Showing Magenta Box in the Slide View, Show/Hide Histogram 
Button, and Histogram Window 
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3. Adjust contrast and brightness using the Image Control (Figure 21) to provide an 
improved view of features on the image. Adjusting these settings allows faint features to be 
more easily seen. 

 

Figure 21: Image Control 
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Notes 
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Chapter 6. NimbleScan Data Analysis 

Chapter 6 describes how to import a scanned image and extract the data using NimbleScan 
software. Refer to the NimbleScan Software User’s Guide v2.6 for computer system requirements 
and detailed information on using the software. 

Step 1. Burst Multiplex Image (4x72K & 3x720K Arrays Only) 

If your files contain the scanned images of 4x72K or 3x720K arrays, follow the steps below to 
burst (separate) each slide image into separate array images. Otherwise, proceed to “Step 2. 
Import Image.” 

1. Select File -> Burst Multiplex Image. The Burst Multiplex Image dialog box appears. 

2. To choose the .tif files to burst, click Add images. 

3. Navigate to the directory containing your array image file (.tif) and select the file. 

4. Click Add to batch. Add both 532 and 635 images for each slide. Multiple slide images can 
be burst at once. 

5. Browse to select the correct multiplex description file (.ncd) on the Design Information 
disk provided with the 4x72K or 3x720K array for the Multiplex description file field. 

6. Browse to select the desired output file destination in the Output burst images to field. 

7. Click Burst. NimbleScan software creates 4 or 3 image files. The array designation (A01 - 
A04 for 4x72K and A01 - A03 for 3x720K arrays) for each bursted image is specified in the 
original image’s file name. For example: 

• <NNNNNA01>_<XXXXX>_<WWW>.tif…<NNNNNA04>_<XXXXX_WWW>.tif 
• <NNNNNA01>_<XXXXX>_<WWW>.tif…<NNNNNA03>_<XXXXX_WWW>.tif 

where NNNNN is the slide’s barcode number, XXXXX is optional user-defined text, and 
WWW is the wavelength (532 or 635). 

8. Repeat steps 1 - 7 for each multiplex image. 

 
Alternatively, you can burst all images designed with the same layout file in a 
batch mode by selecting all files to burst in step 2 above. 

Step 2. Import Image 

1. Select File -> Open. The Open an Alignment dialog box appears. 

 
Open and grid the 532 and 635 images separately. 

2. Navigate to the directory containing your array images and select one image.  

3. Select the design file (.ndf) in the Design Information disk provided with your array. This 
file describes the placement of the probes on the array. 

4. Click Open. For 2.1M arrays, NimbleScan software will split the image into 3 subarrays 
and display each subarray under a separate tab. 
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Step 3. Extract Image 

1. Select the auto brightness/contrast adjust function.  
 
 

2. Select the auto align tool to overlay the grid on the array. Alternatively, select Analysis -> 
Auto Align. For 2.1M arrays, the auto align feature will overlay the grid on all 3 subarrays 
at once. 

 
If the software indicates auto alignment was not successful, perform a manual 
alignment as described in the NimbleScan Software User’s Guide. 

3. Zoom into the top corner of the array with the zoom tool. Check to make sure all fiducial 
controls align correctly with the grid. For 2.1M arrays, check grid placement for the images 
on the A01, A02, and A03 tabs and adjust if necessary. 

 Good Alignment Poor Alignment 

  

Figure 22: Examples Showing Good and Poor Grid Alignments 

4. If necessary, adjust the grid by clicking on the green highlighted square located in the 
corner. Move this square so that the corner fiducial controls line up correctly with the grid. 
Move to each corner using the jump to location buttons. For 385K, 2.1M, and 3x720K 
arrays, also check the center fiducial controls. 

5. Select File -> Save to save the gridded image. 

6. If you are analyzing data from a 4x72K or 3x720K array, proceed to “Step 4. Confirm 
Experimental Integrity (4x72K & 3x720K Arrays Only).” If you are analyzing data from a 
385K or 2.1M array, proceed directly to “Step 5. Generate an Experimental Metrics 
Report.” 

Step 4. Confirm Experimental Integrity (4x72K & 3x720K Arrays Only) 

A unique STC should have been added to each experimental (IP) and control (input) sample 
pair prior to loading onto 4x72K or 3x720K arrays as described in Chapter 4, Step 1. This 
control hybridizes to probes on the microarray and enables you to confirm the sample identity 
on each array and ensure integrity of the experiment. STC probes are placed as repeating sets of 
20 along the perimeter of each array and as two 4 x 5 blocks in the upper left corner and in the 
center of the array (Figure 23). Roche NimbleGen recommends performing a sample tracking 
analysis (refer to page 42) and visually checking the STC features along the perimeter (refer to 
page 44) to confirm that the correct sample has been added to each array. 
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Figure 23: Location and Numbering of Sample Tracking Control Probes on  
a 3x720K Array 

Location of 
Sample Tracking 
Control Probes 
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Performing a Sample Tracking Analysis 

When you run a Sample Tracking analysis, NimbleScan software generates a Sample Tracking 
report based on signal intensities of features in the two 4 x 5 blocks with Sample Tracking 
Control probes (Figure 23). Using this report and sample records from your experiment, you 
can confirm the intended sample was hybridized to the intended array. 

1. Select Analysis -> Sample Tracking. 

2. Click Add files. 

3. Select all gridded 532 nm images for the experiment (for example, select 4 images for 
4x72K arrays). 

4. Click Add to List. 

5. Click Browse to select the destination of the output file. To view the output file in 
Microsoft Excel, save as an .xls file. 

6. Click Run to start the analysis. 

7. Open the Sample Tracking report in spreadsheet software, such as Microsoft Excel. An 
example report is shown in Figure 24. 

• Confirm that the Image ID, Design ID, and Design Name are accurate. 

• Enter the Sample Name and Input STC in the appropriate spreadsheet cells. The Input 
STC is the unique STC number added to each sample before hybridization. 

• For each array, review the signal intensity and the Absent or Present call for each of 
the up to 20 STCs that Roche NimbleGen may provide. The STC identified as Present 
should be the same as the Input STC you entered for the sample. 

• Ensure that a Present call is reported for only the unique STC added to the sample. If 
more than one Present call is reported, the integrity of your data could be 
compromised due to cross-contamination that occurred during sample preparation, 
loading, or hybridization. The extent of cross-contamination that can be tolerated 
depends on your samples, experimental setup, and experimental goals. Roche 
NimbleGen recommends repeating experiments that show cross-contamination. 

• Select File -> Save to save the changes to the file. 
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Figure 24: Example of a Sample Tracking Report 
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Visually Checking STC Features 

1. If necessary, zoom into the upper left corner of the array with the zoom tool. 

 

2. Locate the repeating set of 20 features along the perimeter of the array. Figure 25 shows an 
example of an array hybridized with a sample containing STC 5. 

 

 

 

Figure 25: Example of an Array Hybridized with Sample Containing STC 5 

3. Survey the entire perimeter of the array. If more than one STC is visible, the integrity of 
your data could be compromised due to cross-contamination that occurred during sample 
preparation, loading, or hybridization. Roche NimbleGen recommends repeating 
experiments that show cross-contamination. 

Step 5. Generate an Experimental Metrics Report 

The Experimental Metrics report provides a set of metrics that can be used to establish 
guidelines for determining the quality of the data. Roche NimbleGen recommends that you use 
these metrics to develop criteria for assessing the overall quality of your microarray 
experiments. The metrics provided will vary according to application, array format, probe 
design, organism, sample type and quality, and hybridization conditions. Refer to the Guide to 
Interpreting the Experimental Metrics Report provided with NimbleScan software. 

1. Select Analysis -> Generate Experimental Metrics Report. 

Feature  
for STC 5 

Feature for STC 5 Feature for STC 5 
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Figure 26: Experimental Metrics Report Dialog Box 

2. In Step 1: Choose the array scan files to analyze…: 

• List box. Identifies the files to analyze. 

• Click Add files and folders to select all gridded images (.tif) for the experiment (for 
example, select 4 images for 4x72K arrays). When the Open dialog box opens, 
navigate to the location of the files. You can select multiple files by pressing the Ctrl 
key and clicking each file name. 

• If you choose the wrong file, click the file name in the list box, and click Remove 
selected. 

• To remove all selected files, click Clear. 

3. In Step 2: Choose the desired algorithm settings…: 

• (Optional) Click Browse to select the sample key file. 

• (Optional) Adjust the settings in the Uniformity blocks fields. For 2.1M arrays, Roche 
NimbleGen recommends the following settings: 4 for horizontal and 18 for vertical. 
For all other array formats (385K, 4x72K, or 3x720K arrays), we recommend the 
default settings (4 for horizontal and 6 for vertical). 

4. In Step 3: Choose the destination file…, type the path to the folder in the Destination file 
field or click Browse to open a dialog box for navigating to the destination folder. 

5. In Step 4: Run the Analysis…, click Run to start the analysis. 

6. Open the Experimental Metrics report in spreadsheet software, such as Microsoft Excel. 
An example report is shown in Figure 27. 
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Figure 27: Example of an Experimental Metrics Report  
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Following is a description of the contents of the Experimental Metrics report: 

• IMAGE_NAME. The name of the analyzed image file. 

• INTERQUARTILE_DENSITY. The interquartile range (IQR) of the raw signal 
intensities. 

• RATIO_RANGE. The ratio range for two-color microarray applications. Ratio range 
is calculated by dividing the array into a grid of uniformity blocks (4 x 18 on 2.1M 
arrays and 4 x 6 on 385K, 4x72K, or 3x720K arrays), calculating the average log2 ratio 
of each block and calculating the range from the block averages. 

  
This metric applies only to two-color applications. 

• SIGNAL_RANGE. The signal range represents the signal range on a per channel basis 
for both one- and two-color microarray applications. Similar to ratio range, the signal 
range is calculated based on the range of signal means from the average signal per 
block. 

• UNIFORMITY_MEAN. The mean signal intensity of all the probes in each uniformity 
block. 

• UNIFORMITY_CV. The coefficient of variation of the block uniformity means. 

• NUM_EMPTY. The number of empty features present on the array. 

• MEAN_EMPTY. The mean signal intensity of empty features present on the array. 

• NUM_EXPERIMENTAL. The number of experimental features present on the array. 

• MEAN_EXPERIMENTAL. The mean signal intensity of the experimental features 
present on the array. 

• NUM_RANDOM. The number of random control features present on the array. 

• MEAN_RANDOM. The mean signal intensity of the random control features present 
on the array. These probes generally have the same length and GC characteristics as 
the experimental probes on the array, and can be used to estimate the amount of 
non-specific binding in the hybridization.  

 
Disregard the LHC and SLOPE metrics provided on the report. LHC controls are not 
used in DNA methylation analysis. 

Step 6. (Optional) Create Pair Reports 

 
In version 2.4 or earlier of NimbleScan software, pair reports (.pair files) were used as 
input for data analysis. In later versions of the software, data analysis (“Step 7. Create 
Scaled Log2 Ratio Data”) can use either .pair or gridded .tif files (generated earlier in 
“Step 3. Extract Image”) as input. 

Pair reports (.pair), the raw data format for NimbleGen DNA Methylation experiments, 
contain the signal intensities for each probe on the array. Create two Pair reports for each array, 
one for the Cy3 image and one for the corresponding Cy5 image. Images from arrays with the 
same design can be analyzed in batch mode. 

1. Select Analysis -> Reports -> Pair. 
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Figure 28: Pair Report Dialog Box 

2. Choose the image files (.tif) to process: 

• Click Add images to select image files (.tif). When the Open dialog box opens, you can 
navigate to the location of the image files. Select multiple files by pressing the Ctrl key 
and clicking each file name. 

• If you choose the wrong file, click the file name in the list box, and click Remove 
selected. 

• To remove all selected files, click Clear. 

3. Browse to and select the appropriate design file name in the Design file (.ndf) field and for 
2.1M arrays, the layout file name in the Layout file (.ncd) field. The .ndf and .ncd files are 
included on the CD/DVD shipped with your arrays. 

4. (Optional) Fine-tune feature quantification: 

Locally Align. When selected, the software shifts a quantification square (without 
overlapping the adjacent features) until it finds the maximum intensity for the feature. 

  
Local alignment is not recommended for 2.1M or 3x720K arrays. 

5. Choose where to save the reports in the Save in field. 

6. Choose the Include controls? option if you want the software to report the raw data for the 
fiducial controls and Sample Tracking Controls. 

7. Click Report to generate the report(s). 
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Step 7. Create Scaled Log2 Ratio Data 

1. Select Analysis -> Methylation -> Compute Ratio Files. 

 

Figure 29: Compute Ratio Files Dialog Box 

2. In Step 1: Choose the data files to process...: 

• List box. Identifies the files to process. 

• Click Add files to select either the .pair file(s) generated in “Step 6. (Optional) Create 
Pair Reports” or the gridded .tif files generated in “Step 3. Extract Image” to process. 
When the Open dialog box opens, navigate to the location of the files. You can select 
multiple files by pressing the Ctrl key and clicking each file name. 

• If you choose the wrong file, click the file name in the list box, and click Remove 
selected. 

• To remove all selected files, click Clear. 

 
All .pair files selected must be from arrays that contain the same design. 

• Position file. Select the positions file (.pos) that corresponds to the raw data .pair files 
specified in Step 1 of the dialog box. The positions file maps each probe on the array 
to its genomic location. Each microarray design has a single corresponding positions 
file on the CD/DVD shipped with your microarrays. 

3. In Step 2: Choose the data channels to ratio...: 

• 532/635 or 635/532. Use the default 635/532 setting. 

• (Optional) Sample key file. Select the sample key file. 

4. In Step 3: Choose the desired algorithm settings...: 

• Probe length. If needed, change the probe length (normally 50 bp). Note that if the 
positions file, described earlier, identifies the probe length, the software automatically 
uses that value. 
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The probe length is reflected in the width of probes in the GFF files generated by the 
analysis. 

• Write all channels to All_pairs.probe. Choose whether to create an All Pairs Probe 
(.probe) file that provides sequence identifier, probe identifier, and signal intensity for 
all files in the analysis. 

• Write a GFF for each channel. Choose whether to create a separate GFF (General 
Feature Format, .gff) file that includes signal intensity information for each channel. 

5. In Step 4: Choose the destination folder..., type the path to the folder in the Destination folder 
field or click Browse to open a dialog box for navigating to the destination folder. 

6. In Step 5: Run..., click Run. It will take some time to complete the analysis. Expect 
processing for each 2.1M array to take at least 5 - 20 minutes to complete based on 
computer speed. 

7. Go to the destination folder that contains the analyzed data and review the files. 

File Format Description 

GFF file (.gff)1 (General Feature Format) A GFF file is an exchange format for 
genomic-based data. A DNA methylation GFF file contains scaled log2 
ratio data, if available. 

All Pairs Probe file (.probe)2 Provides sequence identifier, probe identifier, and signal intensity for 
multiple data channels in the same row. 

1 Open with SignalMap software to view data graphically or with a text editor to view data in a table format. 

2  View using a text editor, such as Microsoft WordPad. 

Step 8. Find Peaks 

1. Select Analysis -> Methylation -> Find Peaks. 

 

Figure 30: Peak-finding via sliding window KS test Dialog Box 

2. In Step 1: Select input GFF file(s)…: 
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• Click Add files to select the ratio data files (.gff) generated in the previous section, 
“Step 7. Create Scaled Log2 Ratio Data.” 
When the Open dialog box opens, navigate to the location of the files. You can select 
multiple files by pressing the Ctrl key and clicking each file name. 

• If you choose the wrong file, click the file name in the list box, and click Remove 
selected. 

• To remove all selected files, click Clear. 

3. In Step 2: Set Threshold Options…, leave the default settings for the following parameters: 

• Sliding window width (bp). Adjusts the width of the sliding window surrounding each 
probe. Increasing this value tests more points around each probe against the rest of 
the array. This in turn gives additional statistical power for resolving positive 
enrichment regions at the expense of lower resolution. The default setting is 750 bp. 

• P-value minimum cutoff (-log10). Probes scoring above this cutoff (default set at 2) 
comprise peaks. Higher -log10 values increase stringency and result in fewer peaks 
being identified. 

• Maximum spacing between nearby probes within peak (bp). Nearby probes equal to or 
less than the specified spacing are consolidated into a single peak. This parameter 
specifies the maximum distance over which high-scoring probes are joined to form 
peaks. The default setting is 500 bp. Increasing the distance between nearby probes 
(e.g. 1,000 bp) within peak may merge peaks that may otherwise be identified as 
separate peaks. 

• Minimum probes per peak. Specifies the minimum number (default set at 2) of probes 
that must be above the cutoff before the region is identified as a peak. Increasing the 
minimum probes per peak (e.g. 4 probes) increases the stringency of peak calling 
because a peak requires more probes to comprise that peak. 

4. In Step 3: Choose the output location…, type the path to the folder in the Select output 
directory field or click Browse to open a dialog box for navigating to the destination folder. 

5. In Step 4: Run…, click Run. It will take some time for the analysis to complete. Expect a 
processing time of at least 20 minutes for each 2.1M array when using the default analysis 
settings. 

Step 9. Map Peaks 

1. Select Analysis -> Methylation -> Map Peaks. 
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Figure 31: Peak to feature mapping Dialog Box 

2. In Step 1: Choose input files…: 

a.  Click Add files above the Peak / data files list box and choose the peak data file(s) 
generated in the previous section, “Step 8. Find Peaks.” 

b.  Click Add files above the Annotation files list box and choose the annotation file(s) 
with the feature information to which to map peaks. The software automatically starts 
scanning the file(s) for annotation tracks and lists them in the Annotation tracks list 
box. 

c.  In the Annotation tracks list box, select “transcription start site” to map peaks to the 
+1 site of each gene. You may also select other annotation tracks to map peaks to that 
feature (e.g. CpG islands). 

3. In Step 2: Choose the annotations to map peaks, leave the default settings for the following 
parameters: 

• Filter out peaks with score <. This parameter eliminates peaks of low confidence from 
the summary report. 

• Map peaks to overlapping features up to. This parameter sets the limit on how far 
upstream or downstream from a given feature the peak must be located in order to 
consider it a mapped peak. Be certain to adjust the upstream and downstream values 
based on the array design being used. 

• For each peak report. The “All pairs of peaks” selection generates a report listing every 
combination of peak and annotation record that map together. The “Nearest feature 
(if any) to each peak” selection generates a report listing only the nearest feature to a 
peak. The “Nearest peak (if any) to each feature” selection generates a report listing 
only the nearest peak to a feature. 

4. In Step 3: Choose the output location…, type the path to the folder in the Destination folder 
field or click Browse to open a dialog box for navigating to the destination folder. 

5. In Step 4: Run…, click Run. 
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6. (Optional) Repeat steps 1 - 5 with these changes: 

a.  Select “Nearest peak (if any) to each feature” in the For each peak report field. This 
report generates a report listing only the nearest peak to a feature. 

b.  Choose a different output location than selected in the previous analysis to prevent 
overwriting of summary reports. 

Step 10. Learn More about Your Data 

Signal Intensity (Raw) Data 

Signal intensity data is extracted from the scanned images of each array using NimbleScan 
software. Signal intensities for each probe are saved in pair files (.txt), the raw data format for 
DNA methylation experiments. View pair files using a text editor. (Refer to “Step 6. Create Pair 
Reports” on page 47 for information on how to create pair files.) 

Scaled Log2 Ratio Data 

Each feature on the array has a corresponding scaled log2 ratio, which is the ratio of the input 
signals for the experimental (IP) and control (input) samples co-hybridized to the array. The 
log2 ratio is computed and scaled to center the ratio data around zero. Centering is performed 
by subtracting the bi-weight mean for the log2 ratio values for all features on the array from 
each log2 ratio value. View log2 ratio data files (.gff) using SignalMap software. (Refer to “Step 
7. Create Scaled Log2 Ratio Data” on page 49 for information on how to create log2 ratio data 
files.) 

P-Value Data 

From the scaled log2 ratio data, a fixed-length window (default = 750 bp) is placed around each 
consecutive probe and the one-sided Kolmogorov-Smirnov (KS) test is applied to determine 
whether the probes are drawn from a significantly more positive distribution of intensity log 
ratios than those in the rest of the array. The resulting score for each probe is the -log10 p-value 
from the windowed KS test around that probe. (Refer to “Step 8. Find Peaks” on page 50 for 
information on how to create p-value data files.) 

Peak Data 

Using NimbleScan software, peak data files (.gff) are generated from the p-value data files. 
NimbleScan software detects peaks by searching for the user-specified number of probes 
(default = 2) above a user-specified p-value minimum cutoff (-log10, default = 2) and merges 
peaks within a user-specified distance (default = 500 bp) of each other. View peak data files 
graphically or in table format using SignalMap software or a spreadsheet software, respectively. 
(Refer to “Step 8. Find Peaks” on page 50 for information on how to create peak data files.) 
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Viewing Peak Data Graphically 

In SignalMap software, position the mouse pointer over each peak to display additional 
information (see table below). 

Field Description 

Score The peak score, which is the average -log10 p-values from probes within 
that peak. 

Pos Genomic coordinates of the peak. 

Viewing Peak Data in a Table Format 

You can also open peak data files (.gff) in a spreadsheet program, such as Microsoft Excel, to 
view data in a table format. See the table above for a detailed description of peak data. 

Summary Reports 

For each annotated gene, NimbleScan software searches for peaks that appear in a specified 
promoter region around the transcription start site (TSS). The region searched is 
design-specific. For most mammalian designs, the search region spans from 5 kb upstream to 
1 kb downstream of the TSS. The region spanned can be adjusted based on the array design. 
(Refer to “Step 9. Map Peaks” on page 51 for information on how to create summary reports.) 

You can view the summary reports using spreadsheet software, such as Microsoft Excel: 

 ArrayID_ratio_peaks_mapToFeatures_All_Peaks.xls: Lists all peaks and maps them to 
promoter regions. Each row in the report lists a peak-transcript pair. For each transcript, if 
more than one peak lies within the promoter region, there will be multiple rows for that 
transcript. 

 ArrayID_ratio_peaks_mapToFeatures_Nearest_Peak.xls: Lists all peaks and maps them 
to promoter regions. Each row in the report lists a peak-transcript pair. For each 
transcript, if more than one peak lies within the promoter region, only the peak nearest to 
the TSS is reported. 

To effectively analyze peak data, you should sort the data in summary reports according to 
peak score, gene name, chromosome, distance to TSS, etc. To sort data in Microsoft Excel, 
highlight row 1 and select Data -> Filter -> Auto Filter. You can then sort individual columns 
by ascending/descending values, top 10 values, or individual values. 

The table below identifies the fields on the summary reports (.xls): 
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Field Description 

PEAK_ID An ID for each peak. 

CHROMOSOME Chromosome associated with the peak. 

PEAK_START First base of the peak on the chromosome. 

PEAK_END Last base of the peak on the chromosome. 

PEAK_SCORE The peak score, which is the average  
-log10 p-values from probes within that peak. 

FEATURE_TRACK The annotation track against which peaks were mapped; 
it is the transcription start site for summary reports. 

FEATURE_STRAND Strand of the transcript. 

FEATURE_START First base of the feature on the chromosome. 

Note: For the transcription start site, feature size is 1; 
therefore, start and end positions are the same. 

FEATURE_END Last base of the feature on the chromosome. 

Note: For the transcription start site, feature size is 1; 
therefore, start and end positions are the same. 

FEATURE_TO_PEAK_DISTANCE Center-to-center distance of peak to feature. 

Name  Gene symbol of the transcript. 

Accession GenBank accession number of the transcript. 

description Full gene name of the transcript. 

ncbi_gene_id NCBI Entrez GeneID of the transcript. 

synonyms Other alias symbol(s) of the transcript. 

Parent The internal identification number of the transcript from 
which this transcription start site is generated. 

PEAK_ATTR Attribute field from the peak GFF file. 

Control Regions on NimbleGen Human and Mouse DNA Methylation 2.1M and 

3x720K Arrays 

For NimbleGen Human and Mouse DNA Methylation 2.1M and 3x720K arrays, probes for 
three types of control regions are included on each slide. These control regions are displayed as 
independent tracks in the .gff files containing the scaled log2 ratio, p-value, and peak data. Each 
probe for a control region is represented three times across the array. An example of positive 
control and experimental results are shown in Figure 32. 

 Positive control regions: Represent regions of known DNA methylation in normal 
somatic tissues, such as H19, GNAS, TSH2B (HIST1H2BA), and XIST, as well as regions 
derived from retroviral LTRs. 

 Negative control regions: Derived from multiple histone genes that exhibit minimal or no 
DNA methylation in normal somatic tissues. 

 NonCG control regions: Correspond to ≥ 1 kb genomic regions with no CpG 
dinucleotides and are included to illustrate the background signal level derived from 
completely unmethylated genomic regions. 
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These control regions assist in analyzing performance of a DNA methylation experiment. In 
most normal tissues, the positive control regions should identify methylated DNA fragments 
within the experimental sample, and the negative control regions should show minimal DNA 
methylation. The nonCG control regions contain no CpG sites. Therefore, these probes should 
not identify methylated DNA fragments in the experimental samples. 

 
Results from positive and negative control regions could vary depending on the tissue 
studied and/or cellular treatment. For example, the TSH2B positive control region is 
methylated in most tissues tested except for testis or lung cancer research samples. 
Similarly, tissues exposed to demethylating reagents such as 5-aza-2-deoxycytidine will 
result in loss of methylation in expected regions. Thus, the control regions are not to be 
used as an indisputable quality measurement for any given array or MeDIP experiment 
but as a point of reference from known DNA methylation patterns found in normal 
healthy tissues. 

 

 

 
 
 
 
 
 
 
 
 

Figure 32: Example of Experimental and Positive Control Tracks from Human Chromosome 6. The three 

experimental tracks (scaled log2 ratio, p-value, and peak data) represent the results obtained from a typical DNA 

methylation experiment. The three positive control tracks (scaled log2 ratio, p-value, and peak data) represent the 

results for the set of probes targeted to the TSH2B positive control region. 

Be aware of the following: 1) Although positive, negative, and nonCG control probes may cover the same 
genomic region as the experimental probes, the control and experimental probe sequences may not match exactly. 
In the case of the above example, the probe sequences are not the same. 2) If negative and nonCG control probes 
covered the region that is illustrated, their data tracks would also be displayed. For simplicity, the negative and 
nonCG tracks are not shown in this example. 

Experimental 
Tracks 
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Control  
Tracks 

 

Scaled Log2 Ratio Data 

Peak Data 

P-Value Data

Scaled Log2 Ratio Data

Peak Data 

P-Value Data 
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Data Provided with Custom Designs 

If your array design was customized, some of the files described above may not be provided. 
For instance, annotation files (.gff) may not be readily available for less common genomes, 
which will result in no summary reports being generated. In addition, the gene description file 
(.ngd) is available only for certain designs, since these files were replaced by annotation files 
(.gff) in newer designs. Also, if a positions file (.pos) is not available (because genomic 
coordinates were not provided for a custom design), no scaled log2 ratio files (.gff), peak data 
files (.gff), or summary reports (.xls) are generated. 
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Chapter 7. Troubleshooting 

This chapter helps you troubleshoot problems that occurred with your microarray experiment. 

Sample Quality 

Problem Possible Cause 
Recommended Corrective 
Action 

260/230 Absorption Ratio is 
less than 1.6. 

DNA sample is contaminated with 
carbohydrate or 
phenol/chloroform.  

Clean up samples using a DNA 
cleanup column or 
phenol/chloroform extraction 
followed by ethanol precipitation. 

260/280 Absorption Ratio is 
less than 1.7. 

DNA sample is contaminated with 
protein. 

Clean up samples using a DNA 
cleanup column or 
phenol/chloroform extraction 
followed by ethanol precipitation. 

260/280 Absorption Ratio is 
greater than 2.0. 

DNA sample is contaminated or 
degraded. 

Clean up samples using a DNA 
cleanup column or 
phenol/chloroform extraction 
followed by ethanol precipitation. 
Or if degraded, repeat the 
experiment. 



Chapter 7. Troubleshooting 

 
 

 
 NimbleGen Arrays User’s Guide: DNA Methylation Arrays v7.1  60 

Labeling 

Problem Possible Cause(s) 
Recommended Corrective 
Action 

DNA sample is contaminated or 
degraded. 

Check absorption ratios and gel 
image. If necessary, clean up 
samples or repeat the ChIP 
protocol. Repeat labeling. 

Primers were not diluted correctly.

ß-Mercaptoethanol was not 
added. 
Diluted primers are older than 4 
months.  

Prepare a fresh dilution of 
nonamer primers, ensuring that 
the ß -Mercaptoethanol is fresh 
(opened less than 6 months). 
Repeat labeling. 

Klenow enzyme is expired or 
degraded. 

Check the expiration date and 
follow the labeling kit’s storage 
requirements. Repeat labeling, 
using fresh enzyme, if necessary. 

Primers are degraded. Store primers at -20°C, protected 
from light, and avoid freeze-thaw 
cycles. Repeat labeling, using 
fresh primers, if necessary. 

Labeling yield is less than 8 μg 
per reaction (or less than  
24 μg total for 2.1M arrays). 

dNTPs are expired or degraded. Check the expiration date, follow 
the labeling kit’s storage 
requirements, and avoid 
freeze-thaw cycles. Repeat 
labeling, using fresh dNTPs, if 
necessary. 

Pellets are not solid. Incorrect ratio of water, 
isopropanol, and salt. 

Repeat labeling, making sure to 
precipitate samples with 110μl of 
isopropanol per reaction. 
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Hybridization 

Problem Possible Cause 
Recommended Corrective 
Action 

The slide was not flush in the 
PMAT. 

Remove the mixer using the Mixer 
Disassembly Tool then reassemble 
using a new mixer. 

Mixer is poorly aligned on 
slide.  

PMAT is not properly calibrated 
(multiple mixers misalign). 

Send PMAT to Roche NimbleGen 
for calibration. 

Hybridization solution does not 
enter the hybridization 
chamber. 

The pipette tip is not situated 
properly on the fill port. 

Refer to page 23 for proper 
loading technique. Ensure that the 
pipette tip is placed firm and snug 
against the fill port before 
dispensing. 

Bubbles formed when loading 
the sample into the mixer’s 
hybridization chamber.  

Air was present in the pipette tip. Use Gilson Positive Displacement 
Pipettes and follow the 
instructions on page 23 for proper 
loading technique. 

Using the pipette, remove the 
bubbles and replace with 
hybridization solution. 

Remove the bubbles or push them 
to the corners using the mixer 
brayer. 

The mixer was not fully adhered to 
the slide due to incomplete 
braying. 

Refer to page 22 for proper 
braying technique. Repeat 
hybridization. 

Sample leaked out of the mixer 
before or during the 
hybridization.  

The mixer port seals/multi-port 
seals were not fully adhered to the 
mixer. 

Refer to page 24 for proper sealing 
technique. Ensure that excess 
hybridization solution has been 
wiped from the ports before 
adhering the mixer port seal/ 
multi-port seal. Repeat 
hybridization. 
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Scanning 

Problem Possible Cause 
Recommended Corrective 
Action 

Scratches and/or fingerprints 
are seen on the array image. 

 

The slide was mishandled or 
dropped.  

Grip the slide only on its edges 
and handle with care. Wear gloves 
when handling slides. 

 

Dust is seen on the array 
image. 

 

 

The array was exposed to 
environmental dust. 

If the amount of dust present is 
small, use a compressed gas 
nozzle to gently blow compressed 
nitrogen or argon gas across the 
array to remove the dust. Rescan 
the array. 

If the amount of dust is excessive, 
repeat all wash steps, dry, and 
scan.  

 Dust or dirt was present in the 
microarray dryer. 

Clean the NimbleGen Microarray 
Dryer or other microarray dryer as 
instructed in its operator’s manual. 
Repeat all wash steps, dry, and 
scan. 

Scratch 

Dust
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Problem Possible Cause 
Recommended Corrective 
Action 

Wash artifacts are seen on the 
array image. 

 

 

Slides were not washed and dried 
completely. 

 

 

Use the recommended microarray 
dryer: the NimbleGen Microarray 
Dryer. 

Repeat the slide wash, dry, and 
scan steps, making sure to 
transfer the slide immediately from 
the wash solution to the 
microarray dryer. Blot residual 
wash buffer from the edges of the 
slide. Make fresh wash buffers for 
each batch of slides. 

Bright streaks are seen on the 
array image.  

The microarray dryer does not 
accelerate fast enough. 

Ensure proper function and 
maintenance of the microarray 
dryer. The microarray dryer should 
achieve a top speed of at least 
1,400 rpm in a minimum of 0.8 
seconds. 

Part of the array is missing 
from the array image. 

The scan area is not specified 
properly. 

Refer to page 33 for instructions 
on how to specify the scan area. 
Repeat the scan ensuring that 
fiducial features are included in 
the scan area.  

Gain or PMT settings are not 
adjusted correctly. 

Refer to the scanner’s 
documentation (or page 35 of this 
User’s Guide if using the MS 200 
scanner) on how to adjust gain or 
PMT settings. Repeat scan. 

Hybridization and/or wash 
conditions are too stringent. 

Check that the hybridization 
solution was prepared correctly 
(refer to page 20) and the 
NimbleGen Hybridization System 
is set to and maintaining 42°C. 
Repeat hybridization.  

Refer to page 25 for proper 
washing technique. Repeat 
hybridization. 

Sample leaked out of the mixer 
during hybridization due to 
incomplete braying. 

Refer to page 22 for proper 
braying technique. Repeat 
hybridization. 

The array image appears dim. 

Cy dye(s) are degraded due to 
exposure to light, ozone, and/or 
humidity. 

Store primers at -20°C, protected 
from light. Maintain ozone levels 
below 20 ppb and humidity levels 
below 40%. Repeat hybridization.  
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Problem Possible Cause 
Recommended Corrective 
Action 

The fiducial features appear 
dim or blank. 

The alignment oligo was either not 
added to the hybridization solution 
or was degraded due to repeated 
freeze-thaw cycles. 

Repeat hybridization, using fresh 
alignment oligo, if necessary. 

Features appear blank on 
portions of the array. 

The slide contains a scratch or 
fingerprint. 

Grip the slide only on its edges 
and handle with care. Wear gloves 
when handling slides. Repeat 
hybridization. 

 One or more bubbles were present 
in the hybridization chamber.  

Repeat hybridization if blank 
regions cover greater than 5% of 
the array area. 

 

  

 Wash buffer dried onto the array 
surface in between wash steps. 

Ensure that slides are transferred 
quickly between wash steps. 
Repeat hybridization. 

Hybridization and/or wash 
conditions are not stringent 
enough. 

Check that the hybridization 
solution was prepared correctly 
(refer to page 20) and the 
NimbleGen Hybridization System 
is set to and maintaining 42°C. 
Repeat hybridization. 

Refer to page 25 for proper 
washing technique. Repeat 
hybridization. 

The array image is too bright. 

Gain or PMT settings are not 
adjusted correctly. 

Refer to the scanner’s 
documentation (or page 35 of this 
User’s Guide if using the MS 200 
scanner) on how to adjust gain or 
PMT settings. Repeat scan. 

Bubble

NimbleGen 
Control Regions 
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Problem Possible Cause 
Recommended Corrective 
Action 

One or more bubbles were present 
in the hybridization chamber, 
and/or there was poor mixing 
during hybridization.  

Repeat hybridization. If the 
problem persists, refer to the 
NimbleGen Hybridization System 
User's Guide for troubleshooting 
information.  

Sample leaked out of the mixer 
during hybridization due to 
incomplete braying 

Refer to page 22 for proper 
braying technique. Repeat 
hybridization. 

The sample pellet was not properly 
rehydrated or mixed with the 
hybridization solution. 

During sample preparation, be 
sure to vortex and spin the sample 
before and after the 95°C 
incubation. Repeat hybridization. 

The array image brightness is 
uneven.  

Array washing was not done 
properly. 

Refer to page 25 for proper 
washing technique. Repeat 
hybridization. 

The array image is uniformly 
yellow and lacks red or green 
saturated features. 

Hybridization and/or wash 
conditions are not stringent 
enough.  

Check that the hybridization 
solution was prepared correctly 
(refer to page 20) and the 
NimbleGen Hybridization System 
is set to and maintaining 42°C. 
Repeat hybridization. 

Refer to page 25 for proper 
washing technique. Repeat 
hybridization. 

Gain or PMT settings are not 
adjusted correctly. 

Refer to the scanner’s 
documentation (or page 35 of this 
User’s Guide if using the MS 200 
scanner) on how to adjust gain or 
PMT settings. Repeat scan. 

The array image is either too 
green or too red. 

Experimental (IP) and control 
(input) samples were not added in 
equal amounts. 

Combined sample pellets and 
hybridization solution should be 
violet in color; pink or blue color 
suggests that too much of one 
sample was added. 

Red and green features appear 
out of alignment. 

Image has not been gridded. Standard procedure is to grid each 
image (Cy3 and Cy5) individually 
using NimbleScan software.  
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Sample Tracking Controls (STCs) 

Problem Possible Cause 
Recommended Corrective 
Action 

STC features are not visible in 
the STC control regions that 
are located along the 
perimeter, in the upper left 
corner, and in the center of the 
array. 

Experimental (IP) and control 
(input) samples were not 
resuspended in an STC, or the STC 
was degraded from repeated 
freeze-thaw cycles. 

Repeat hybridization, using a fresh 
STC, if necessary. 

STC features representing 
multiple STCs are visible on 
the array image or reported in 
the Sample Tracking report. 

Sample integrity was 
compromised during sample 
preparation, loading, or 
hybridization. 

Repeat hybridization, ensuring the 
following: 

 The mixer is fully adhered to 
the slide before loading 
sample. Refer to page 22 for 
proper braying technique. 

 Excess sample is removed 
from around the loading ports. 
Refer to page 24 for proper 
sealing technique. 

 The mixer port 
seals/multi-port seals were 
not fully adhered to the mixer 
after loading sample. Refer to 
page 24 for proper sealing 
technique. 
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Data Analysis 

Problem Possible Cause 
Recommended Corrective 
Action 

Experimental (IP) and control 
(input) samples were of poor 
quality. 

Refer to Chapter 2. Sample 
Preparation & QC (page 13). 
Repeat labeling and hybridization. 

Data appear noisy. 

Species/strain variation between 
experimental (IP) and control 
(input) samples. 

If Experimental (IP) and control 
(input) samples are of different 
species or strains, data may be 
noisy. 

Hybridization and/or wash 
conditions are not stringent 
enough. 

Check that the hybridization 
solution was prepared correctly 
(refer to page 20) and the 
NimbleGen Hybridization System 
is set to and maintaining 42°C. 
Repeat hybridization. 

Refer to page 25 for proper 
washing technique. Repeat 
hybridization. 

No peaks are detected. 

Experimental (IP) sample was not 
significantly enriched. 

Check enrichment level of 
experimental (IP) sample 
compared to control (input) 
sample. 

Peaks have low confidence 
values. 

Experimental (IP) sample was not 
significantly enriched. 

Check enrichment level of 
experimental (IP) sample 
compared to control (input) 
sample. 

The slide-mixer assembly reached 
room temperature between the 
hybridization and wash steps. 

Remove the slide-mixer 
assemblies one at a time from the 
NimbleGen Hybridization System, 
immediately disassemble, and 
place in Wash Buffer I.  

Experimental (IP) sample was of 
poor quality. 

Refer to Chapter 2. Sample 
Preparation & QC (page 13). 
Repeat labeling and hybridization. 

The log2 ratio values are 
muted. 

Hybridization and/or wash 
conditions are not stringent 
enough. 

Check that the hybridization 
solution was prepared correctly 
(refer to page 20) and the 
NimbleGen Hybridization System 
power is set to and maintaining 
42°C. Repeat hybridization. 

Refer to page 25 for proper 
washing technique. Repeat 
hybridization. 
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Problem Possible Cause 
Recommended Corrective 
Action 

The wrong .ncd file was specified. Refer to page 39 for instructions 
on how to specify the correct .ncd 
file when bursting multiplex 
arrays. 

The image was corrupted. Rescan array. 

NimbleScan fails to open the 
image TIFF file or Multiplex 
images fail to burst. 

A non-16-bit TIFF image was 
specified. 

Rescan and save as a 16-bit TIFF 
image. 

NimbleScan software reads only 
16-bit grayscale images. 

The entire array area was not 
scanned.  

Refer to page 33 for instructions 
on how to specify the scan area. 
Check the image using the 
scanner software and rescan. 

The scanned area is too large. Refer to page 33 for instructions 
on how to specify the scan area. 
Crop the image in NimbleScan 
software and attempt bursting 
again. 

Multiplex images were burst 
incorrectly. 

 

The array area is not centered in 
the scanned image. 

Refer to page 33 for instructions 
on how to specify the scan area. 
Crop the image in NimbleScan 
software or rescan if necessary. 

Fiducial features are dim. Perform a manual alignment as 
described in the NimbleScan 
Software User’s Guide. 

The auto align function fails to 
grid the array image. 

 
NimbleScan v2.4 or later was not 
used. 

Install the latest version of 
NimbleScan software. Reload the 
image and perform the auto align 
function.  

The auto align function 
improperly grids the array. 

Bright artifacts are present in the 
corners of the array image. 

Perform a manual alignment as 
described in the NimbleScan 
Software User’s Guide. 

 

 



 

 
 

 
 NimbleGen Arrays User’s Guide: DNA Methylation Arrays v7.1 69 

Appendix A. Limited Warranty 

ROCHE NIMBLEGEN, INC. 
NIMBLEGEN ARRAYS 

 

1. Limited Warranty 

A. Products: Roche NimbleGen, Inc. (“Roche NimbleGen”) warrants that its Products 
conform to its published specifications and are free from defects in material or 
workmanship. Customer’s sole and exclusive remedy (and Roche NimbleGen’s sole and 
exclusive liability) under this limited warranty shall be to either (a) replace the defective 
Products, or (b) provide Customer with a refund, as solely determined by Roche 
NimbleGen. 

B. Under no circumstances shall Roche NimbleGen’s liability to Customer exceed the 
amount paid by Customer for the Services and Products to Roche NimbleGen. Roche 
NimbleGen will bear all reasonable shipping costs if service is re-performed at Roche 
NimbleGen or the Products are replaced. This warranty does not apply to any defect or 
nonconformance caused by (i) the failure by Customer to provide a suitable storage, use, 
or operating environment for the Materials or Customer’s submission of substandard 
quality Materials or contaminated or degraded Materials to Roche NimbleGen, (ii) 
Customer’s use of non-recommended reagents, (iii) Customer’s use of the Products, 
Materials or Data for a purpose or in a manner other than that for which they were 
designed, (iv) the failure by Customer to follow Roche NimbleGen’s published protocols; or 
(v) as a result of any other abuse, misuse or neglect of the Products, Materials or Data by 
Customer. This warranty applies only to Customer and not to third parties. 

C. TO THE FULLEST EXTENT PERMITTED BY APPLICABLE LAW, ROCHE NIMBLEGEN 
DISCLAIMS ALL OTHER REPRESENTATIONS, AND WARRANTIES, EXPRESS OR IMPLIED, 
WITH RESPECT TO THE PRODUCTS, SERVICES AND DATA, INCLUDING BUT NOT 
LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE OR NON-INFRINGEMENT. CUSTOMER’S SOLE REMEDY FOR 
BREACH OF WARRANTY IS STATED ABOVE. 

D. Any action by Customer against Roche NimbleGen for Roche NimbleGen’s breach of 
this warranty must be commenced within 12 months following the date of such breach. 
Notwithstanding such 12-month period, within twenty (20) days of the delivery of Data 
and/or Products to Customer, Customer must notify Roche NimbleGen in writing of any 
nonconformity of the Services and Products, describing the nonconformity in detail; 
otherwise all Services and Products shall be conclusively deemed accepted without 
qualification. 
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2. FURTHER LIABILITY LIMITATION 

TO THE FULLEST EXTENT PERMITTED UNDER APPLICABLE LAW, ROCHE NIMBLEGEN 
SHALL NOT HAVE ANY LIABILITY FOR INCIDENTAL, COMPENSATORY, PUNITIVE, 
CONSEQUENTIAL, INDIRECT, SPECIAL OR OTHER SIMILAR DAMAGES, HOWEVER 
CAUSED AND REGARDLESS OF FORM OF ACTION WHETHER IN CONTRACT, TORT 
(INCLUDING NEGLIGENCE), STRICT PRODUCT LIABILITY OR OTHERWISE, EVEN IF 
ROCHE NIMBLEGEN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
CUSTOMER UNDERSTANDS THAT ANY RISKS OF LOSS HEREUNDER ARE REFLECTED 
IN THE PRICE OF THE SERVICES AND PRODUCTS AND THAT THESE TERMS WOULD 
HAVE BEEN DIFFERENT IF THERE HAD BEEN A DIFFERENT ALLOCATION OF RISK. 

If you have any questions concerning service of this product, please contact your 
local Roche Microarray Technical Support. Go to www.nimblegen.com/arraysupport for 
contact information. 

Evidence of original purchase is required. It is important to save your sales receipt or 
packaging slip to verify purchase. 

 

 

http://www.nimblegen.com/arraysupport/
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